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To navigate round the guide:
Any item in the contents can be clicked to go to that item.
At the top of every page is a link that will go to the contents list.
Any items highlighted will go to the item, e.g. this will go to the
contents list.
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[bookmark: _Toc63512853]What is it?
	Foxclone is a Linux based image backup, restore and clone tool using a simple point and click interface. It takes images of the partitions on your hard drive (HDD) or solid-state drive (SSD) and stores them for later restoration. Image files can optionally be compressed to save space. Foxclone is a front end for the Linux terminal utility partclone.
[image: ]
Limitations:
· 64 bit systems only.
· Local drives only 
· RAID – unlikely.
· LVM – no.
· English only.
*	e.g. the MS reserved partition in a windows 10 installation or a LUKS encrypted partition. foxclone does a byte-by-byte copy of the whole partition as it is unable to determine the used blocks. So, dependent on the size of the partition, it can take a long time
**	as long as the total size of partitions on the source drive is less than the size of the new drive and all the unallocated space is at the end of the drive.
Backup and restore:
· GPT and MBR/legacy/MSDOS partition tables.
· FAT32, NTFS and ext4 partitions.
· Unknown partition types*.
· Encrypted partitions*.
Clone:
· Direct drive to drive.
· To drive from a full backup.
· From a larger drive to a smaller drive**.

[bookmark: _Toc63512854]How should it be used?
	It cannot be stressed strongly enough – a partition backup utility such as foxclone or clonezilla or any other image backup tool should not be used as your only backup tool.
	A partition backup utility is there for disaster recovery:
A failed or failing drive.
An operating system borked (usually by the user) to the extent that it will no longer boot.

	It should not be used as a daily backup tool, why?
It is a manual process, you cannot automate it, at some point you will forget to do it.
It is slow, you have to backup up complete partitions. There is no incremental or differential backup to speed things up.
It doesn’t understand files and folders, just partitions. Mess up a few files, you have to restore the entire partition probably overwriting newer files that were perfectly okay, potentially leaving you worse off.
	Problem dependent, it can be a sledgehammer to crack a nut.

	An image backup tool, such as foxclone, should be used in conjunction with a file level backup tool(s). There are plenty of excellent Linux file backup utilities, timeshift, backintime, luckybackup to name just three. These:
Can be automated to run daily or at whatever frequency you want.
Are incremental – they only backup files that are new or changed – so quick.
Allow you to restore individual files – just the ones you broke!

	Use file level backup as your first line of defence.

	Use image backup as your last line of defence.



[bookmark: _Toc63512855]Installation
	Download the iso and burn to either a USB stick or CD. 
[bookmark: _Toc63512856]Linux
	If burning to a USB stick use the USB Image Writer that comes with your distribution. The example is based on Linux Mint.
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Click to navigate to the download location




[image: ]





Click to select the device – if it doesn’t appear, unplug and plug it in again







	If burning to a CD, there are many Linux utilities, xfburn is one of the simplest. Install from your software manager/centre if not installed.
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Click to navigate to the download location










[bookmark: _Toc63512857]Windows
	There are a number of windows tools available. The example uses rufus, which can be downloaded from https://rufus.ie/. The download is a single executable.
[image: ]Click to browse to the foxclone iso file
Click to select USB stick

[image: ]

[image: ]
Select Write in DD Image mode. If ISO image mode is selected it is likely that when you boot the usb stick you will end up at the Grub> prompt!

	The iso can be burnt to CD using windows built in CD writing utilities.
[bookmark: _Toc63512858]Boot        
	At the manufacturer’s splash screen, press the key to get into the boot menu[footnoteRef:1]. This key varies across PCs, as an example for a Lenovo Thinkpad it is F12, on my desktop it is F11. Consult your user manual to find out what the key is or google. Do not confuse the boot menu with the boot priority order settings in BIOS. The boot menu is a one time selection for the device to use to boot the PC. It overrides the normal boot priority order. The next time you boot, the PC will revert to the normal boot order. Virtually all BIOSes support this feature, they just do it differently. [1:  	Trouble with BIOS recognising the Fn key on boot? If using a wireless keyboard, try with a wired keyboard.] 

	The example shows the boot menu for a Thinkpad T430. 
[image: ]

	If the USB stick (or CD) does not appear in the menu and/or it won’t boot:
UEFI and legacy boot. If foxclone will not boot in UEFI mode, make sure that secure boot is disabled in BIOS. Still no joy – try enabling CSM (compatibility support mode) if that is an option. There may also be other settings for USB boot. No further guidance can be offered – all BIOSes are different.
The iso is a minimal 64 bit ubuntu installation running a 5.4 kernel. This may not boot on some older hardware.
	If the USB stick boots, then fails to load – have you got multiple USB drives plugged in? If so, remove all USB drives except for the foxclone USB stick and reboot. When the foxclone USB has booted, then plug in the other USB drives before running foxclone.
	Still not booting, if failing to boot from a USB stick, try:
· Plugging the USB stick into a USB2.0 port not USB3.x. If that fails…
· Burn the foxclone iso to CD and boot from that.
	If booting in legacy mode you will be presented with the isolinux start screen. It will automatically boot into foxclone.
[image: ]

	If booting in UEFI mode you will get grub. You need to press ENTER to boot foxclone.
[image: ]


[bookmark: _Toc63512859]The desktop
[image: ]
	Double click on any of the launchers on the desktop to start:
Foxclone.
Display – foxclone should boot into the native resolution for your PC, if not use this to change display resolution or if you want a ‘larger’ display for improved readability use it to reduce screen resolution. 
Pale Moon – the web browser for access to the foxclone website.
The User Guide – this document.
The File Manager – for access to the files on your system or the network.
[bookmark: Desktop]	Bottom left on the panel is the main menu, described further here, with launchers for foxclone & the user guide. These can be activated with a single click.
	Bottom right are icons displaying:
[bookmark: Desktop_network]Network status – see here for connecting to a network.
CPU temperature[footnoteRef:2] in °C. [2:  	Foxclone places a heavy load on the CPU, using all cores when backing up or restoring. Check the temperature periodically. With a laptop make sure the inlet/outlet vents are clear. The CPU should not overheat – it will be automatically throttled when the temperature typically exceeds 100°C.] 

Battery status – if present.
Time/date.
[bookmark: _Toc63512860]Foxclone
	Before starting foxclone, plug in any external drives you want to use.
	To start foxclone, double click on the launcher on the desktop or single click on the launcher in the panel, or foxclone can be found in the menu under system tools. 
	When it starts, foxclone will search the system for information on the attached drives.
[image: ]

	It will then display the main window.
[image: ]Use the tabs to select the function you want


[bookmark: _Toc63512861]Backup
[image: ]
Where do you want to save it?

What do you want to backup?


	Basic information is shown for each drive – its name, size and partition table type. Click on the drive that you want to backup (you can only select one). Box 2 will immediately show the partitions on that drive.
	Potential error messages are:
	[image: ]
	You cannot backup the drive that you booted from because you cannot backup a live filesystem – it might change during the backup and corrupt the backup.

	[image: ]
	[bookmark: NoPartTable]Most likely, this was a new drive and you used Disks to format it. You can use it as a backup destination, but cannot back it up. Nor can the drive have an operating system on it. The solution is to reformat the drive with a partition table and new partition(s).


In both cases, select another drive to backup.
[image: ]
	Hover the mouse over the box and a hint will displayed describing the information shown (this works for most other boxes as well). You can use the scroll bars to scroll down or right to see more information. Depending on whether the drive has a GPT (UEFI) or MSDOS (legacy) partition table you get slightly different information. 
	Select the partitions you want to backup in box 2. For a full backup, just select all partitions. 
[image: ]Any partition that starts with an asterisk (*) has an operating system on it – you can scroll right to see what it is. It may or may not find windows, here it has.


	You cannot select
	A swap partition – there is no data to backup. foxclone automatically saves the details[footnoteRef:3] on a swap partition and on a restore will recreate it. [3:  	Primarily the UUID – when the swap partition is recreated it uses the same UUID so that Linux does not hang on boot for 90 seconds looking for a swap partition it can’t find.] 


	
	An extended partition on a drive with a legacy partition table – an extended partition is just a special entry in the partition table that points to another partition table that contains details on the logical partitions.



	Not happy – wrong drive, not the partitions you expected, just click on a different drive in box 1 and start again.
	Box 3 is now asking for the drive where you want to save the backup.Note the source drive is missing in box 3 – you can’t save a backup to the drive you want to backup. 

[image: ]Note sde is showing as a partition table type LOOP. This is a drive without a partition table.

	Click on the destination drive and box 4 will be populated with the partitions on that drive.
[image: ]It helps to add labels to all partitions. Where there is a label, foxclone will display it in brackets [ ]. This makes it easier to identify which partition is which.


	Click on the partition where you want to save the backup.
	If there is not enough space on the selected partition, foxclone will display a warning message. 
[image: ]Foxclone cannot predict how much space will be required when the backup is compressed, so it simply compares the total size of the backup with the free space available.

	When a partition has been selected with enough free space, the
 Save to File button is enabled. 
[image: ]





Click to choose the folder & filename for the backup.


	This then opens up the partition you selected as the destination with the file save dialog where:
[image: ]You can create a new folder or double click on an existing folder to open it up as the destination
Change or accept the backup filename. The default is the current date as YYYYMMDD. Foxclone will append .backup to the filename you specify.

Click Save when finished, or cancel to go back.
[image: ]	Foxclone will now display a confirmation window showing the partitions to be backed up and the destination folder/filename. 
	This is the point of no return; you are being asked to confirm the backup before starting. Click on OK and the backup will start.
	As the backup progresses it will display a progress window.
[image: ]It provides some information on the current partition being backed up, showing progress and overall progress.
This is the only progress window that has a cancel button on it. Click it once only, it may take a few seconds to respond. You will have to manually delete any backup files that have already been created.
When the backup is complete, the Add Note and Finish buttons will be enabled.
	To add a note, click on the note button.
[image: ]

	Click Finish to finish – backup done! Then Quit on the main window and shutdown from the main menu.
[bookmark: _What’s_in_a][bookmark: _Toc63512862]What’s in a backup?
	The screenshot shows the contents of a backup folder. All the filenames start with 20191126 full. This was the name specified in the backup.
[image: ]	The *.backup file is a text file created by foxclone describing the backup. It is read by foxclone when a restore is done.
	The *.grub is a copy of the first MB of the drive. On a drive with a legacy partition table this is needed to copy grub – the bootloader[footnoteRef:4].  [4:  	The first stage bootloader lives in the first 512 bytes on the drive. On a legacy install the second stage bootloader ‘hides’ in the space between the end of the partition table and the start of the first partition (usually at 1MB). This is not required on a GPT format drive but foxclone still copies the first 1MB of the drive and creates a grub file.] 

	The *.note.txt file is a text file containing the notes made during a backup. If no notes were made there will be no file.
	This is then followed by pairs of files for each partition backed up. The *-log.txt files are log files created by foxclone when doing the backup. They are for information and serve no other purpose.
	The *.img files are the backup image files for each partition that was backed up. The end of the filename varies depending on the settings. If the filename ends:
*.img – then this is an uncompressed image file.
*.img.gz – this is a compressed image file.
*.img.000 or *.img.gz.000 – this file is part of an image set for the specified partition where the image has been split across several files where the maximum file size is specified in settings. The next file in the set will be 001 and so on.
	Finally, the *.sfdisk file is a text file created by sfdisk describing the partition table. It is used by sfdisk to recreate the partition table when doing a restore.
[bookmark: _Toc63512863]Deleting backup files
	At some point you will fill up the backup drive and want to delete old backups. The backup files are owned by root, so you can’t delete them as an ordinary user. 
[image: ]
	In your file manager, navigate to the folder containing the backup and right click on it, in the example MBRfull7bodhi, and ‘open as root’. You will then be able to delete the backup files.
[image: ]
[bookmark: _Restore][bookmark: _Toc63512864]Restore
Restore will only restore to the drive the backup was taken from. If you want to restore a full backup to a different drive use Clone file to drive. Note – backups taken using earlier versions may incorrectly identify the drive to restore if there are two identical drives in the system, see version history.
	Box 1 lists all the drives found on the system, select the drive containing the backup. Box 2 will be immediately populated with the partitions on the drive.
[image: ]
Where is the backup?

	As soon as you click on a partition in box 2, the file open window will appear showing the contents of that partition.
[image: ][image: ]Navigate to the backup file and double click on it or click the Open button.
This will open the backup file, read the content and populate boxes 3 and 4 on the main window.

[image: ]Only if there is one
Contents of the backup

Box 3 shows the partitions in the backup and box 4 shows the current partitions on the destination drive.Current content on the destination drive

You can only restore to the drive that you took the backup from. If you want to restore to a different drive use clone.
	All the partitions are automatically selected, if you want to change this, select the partitions you want to restore in box 3. 
[image: ]If you try to de-select ‘restore partition table’ and get this warning, you should restore all partitions (and hope that the backup is a full backup).
	Foxclone gives the user the choice on what partitions to backup and what to restore. With this flexibility comes the responsibility to ensure the backups held are sufficient. The first backup should always be a full backup. Thereafter if no changes are made to the partition sizes or positions, a backup of an individual partition may be sufficient. For example, a later backup of a /home partition because that is likely to see more change than the / partition – hence keep a more up-to-date copy. But, shrink, grow or move any partition – do a full backup beforehand.
A further example – say you have a dual boot setup with windows and you have messed up the contents of the windows partition so it won’t boot. All you want to do is restore that to a working version, then okay, you can just restore that partition. If you have changed anything else on the drive, say increasing the size of one of the Linux partitions, and all you did was restore the win partition you would screw up the rest of the drive – Linux wouldn’t boot. You need to be careful and aware of what you are doing!
	When the appropriate partitions have been selected in box 3, click the Restore button to continue. You get a confirm window – showing what will be restored, last chance to change your mind.
[image: ]

OK to continue and the restore will start.



[image: ]

A progress window is displayed. Finish and View Log are enabled on completion.


[image: ]Clicking on View Log will display a log showing the partition table details and then the output from partclone for each partition restored.


	It displays a file saved in /tmp/foxclone/<backup filename>.clone.log. If you want a permanent copy then copy this file to a location on your existing drives using the file manager.
	Click Finish to close the window, foxclone will reread the drives before enabling the main window. Then Quit on the main window to exit foxclone
There is no cancel button on restore. To cancel a restore part way through would leave the drive in an unknown state – there would be a complete mismatch between the partition table and the partitions on the drive. It would not boot. Hence, once started, a restore must run to completion.
[bookmark: _Toc63512865]Clone
	Use clone to:
Change the main system drive from a smaller to larger drive.
Replace an HDD with an SSD. You can clone from a larger drive (or backup) to a smaller drive as long as the total space used by the partitions is less than the size of the smaller drive and all the unallocated space on the larger drive is at the end.
	This Will not work
	


	This Will work
	



Replace a failed or failing system drive.
	Clone provides two options, selectable through the drop-down on the clone window:
[image: ]
Drive to drive – direct copy from one drive to another.
From backup file to drive – using a previously created full[footnoteRef:5] backup of the source drive. [5:  	It is up to the user to make sure that the backup selected is a full backup.] 

[bookmark: _Toc63512866]Clone drive to drive
[image: ]	With a desktop this is straightforward – find a spare SATA slot on the motherboard and plug the new drive in with SATA cable. With a laptop it helps to have one of these – a SATA to USB cable, not expensive at around $10. Connect the new drive to it and plug into a USB port.



	Click on the source drive in box 1 and the destination drive in box 2, then click Clone to proceed. If there is not enough space on the target drive a warning message will pop up. Shrink the partitions with gparted and try again, see here for help on re-sizing partitions.
[image: ]

[image: ]	When the partitions on the source drive will fit on the target drive (no warning message), click on the Clone button. A confirm window will open. This shows the source and target drives together with the partitions on the source drive. This is the point of no return. 
Click OK to start the clone.

[image: ]
[bookmark: _Hlk63498419]	A progress window will appear, the Finish  and View Log buttons are enabled on completion. 

[image: ]
	Clicking the View Log button will display the log, showing details on the partition table and each partition cloned to the new drive.
	Clicking Finish  will close the progress window. Foxclone will then re-read the drive information before enabling the main window.

	There is no cancel button on clone. To cancel a clone part way through would leave the clone drive in an unknown state – there would be a complete mismatch between the partition table and the partitions on the drive. It would not boot. Hence, once started, a clone must run to completion.
	In the main window, then click Quit to exit foxclone.
[bookmark: CloneDrive]	There are now two issues to resolve:
Un-allocated space – there will be unallocated space on the cloned drive. Foxclone does not adjust the sizes of any partitions to fit the new drive. This can be done with gparted[footnoteRef:6], see here for help. [6:  	If the clone is a boot drive with an operating system, you may want to check that it boots first before adjusting the size of any partitions.] 

Booting – there are now two identical drives connected to the system[footnoteRef:7]. If the cloned drive contains an operating system, BIOS is likely to get confused about which drive to boot from and start throwing errors or boot from the source drive. The simplest solution is to disconnect the source drive, replace it with the clone drive and reboot. [7:  	Specifically, the partitions on the clone drive have identical UUIDs to the partitions on the source drive. When booting Linux with grub it looks for the boot partition based on the UUID of the partition. A UUID is a unique reference for every partition, e.g. ddc976e3-bc24-4b8d-9151-a72c9013d3e8.] 


[bookmark: _Clone_File_to][bookmark: _Ref35954781][bookmark: _Toc63512867]Clone File to Drive	Return to restore

[image: ]
	Starting point – you must have a full backup of the drive you are cloning from.
	Select Backup file to Drive from the drop down. Boxes 1 and 2 are just like a restore – which drive and which partition is the backup on?
As soon as you click on a partition in box 2 it will open up the file dialog to get the backup file. 

[image: ]

In the example shown, the backup is in a folder MBRfull7bodhi and it contains a legacy boot installation with windows 10 and Bodhi Linux.




[image: ]	When the backup file is opened, box 3 is populated with the contents of the backup and box 4 is inviting you to select the target drive. Once the target is selected, the Clone button is enabled, click to continue.

As with clone ‘drive to drive’, if you click on a drive and it isn’t big enough you will get a warning and invitation to select a different drive.



	A confirm window will pop up identifying the backup & its contents and the target drive. Last chance to change your mind.
[image: ]

Click OK to start the clone.




	A progress window will appear. The Finish and View Log buttons are enabled on completion. 
[image: ]
Clicking on View Log will display a log showing what foxclone has done.
[image: ]
Click Finish to close and return to the main window, click Quit to exit foxclone.

[bookmark: _Toc63512868]Verify
	Verify can be used to check the integrity of backup files.
[image: ]
Select the drive containing the backup files and box2 will show the partitions on the drive. Select the partition containing the backup and a file open dialog will appear. 
[image: ][image: ]Navigate to the backup file and double click on it or click the Open button.
This will open the backup file, read the content and populate box 3 on the main window.

	Click on the partition backup to verify[footnoteRef:8] and then click on the Verify button. [8:  	Extended, swap or partitions with unknown filesystems cannot be selected.] 

[image: ]
[image: ]A progress window will appear. When finished the Finish and View Log buttons will be enabled.
	The log shows the status of the verify. As each image is checked it creates a text file with the outcome and saves this file in the same folder as the backup. The format of the filename is:

<backup filename>.<partition>.img.chk, e.g.
20191107.sda2.img.chk
[image: ]The log window shows the outcome of all image checks carried out. Not just the one that has just been done, but also any that have previously been verified.

[bookmark: _Settings][bookmark: _Ref27952330][bookmark: _Toc63512869]Settings
[image: ]
	Compression – when selected, backup image files will be compressed and will take the form *.img.gz. If de-selected the image files are not compressed and take the form *.img.
	Compression levels – are selectable in the range 1 to 9 where 1 is least compression (quicker) and 9 is most compression (slower). Foxclone uses pigz to compress image files. It is multi-threaded unlike gzip, so the more cores in the CPU the faster it will be. During a backup you will see high CPU utilisation.
The default compression level has been set at 1. The following shows performance in a number of scenarios with different compression levels.
[image: ]
i7-3632QM (quad core) backing up a Linux Mint root partition from SSD to HDD (5400rpm), both ends SATA3.
Compression achieves a 2/3 reduction in the image file size.
Very similar results were obtained with an external USB3 HDD (Samsung M3 portable).
[image: ]

i5-3210M (dual core) backing up a Linux Mint root partition from mSATA SSD to HDD (5400rpm). Source is SATA2, destination is SATA3. Image file size is reduced by 2/3.


[image: ]
i5-3210M (dual core) backing up a NTFS windows 10 partition (C:) from SSD to HDD (5400rpm). Both ends are SATA3.
Compression is achieving a 50% reduction in image file size.


[image: ]Effective throughtput is around 6 GiB/min with a quad core i7 and SATA3. This drops to 5 GiB/min with a dual core i5 and drops further to 4 GiB/min with a SATA2 interface.
	Split files – unlikely to provide much benefit with modern filesystems, but included for completeness. It provides the ability to split the backup image files over several files against a defined maximum file size. FAT32 has a file size limit of 4GB[footnoteRef:9]. The file size limits on NTFS and ext4 partitions are such as to be irrelevant. [9:  	To be precise, 4GB less one byte, i.e. (232 – 1) bytes.] 

When split files has been selected, the image files will take the form *.img.000, *.img.001, etc.
Return to backup content

	When the destination for a backup is a fat32 partition, ‘split files’ is automatically switched ON with a 2048MB file size. This is reset after the backup.


[bookmark: _What_else_is][bookmark: _Toc63512870]What else is in the iso?
[bookmark: _Toc63512871][image: ]Accessories

Return to desktop




[bookmark: _Toc63512872]Fox guide 
	This document.
[bookmark: _Toc63512873]File manager
	The file manager is Thunar[footnoteRef:10].  [10:  	Default in the XCFE desktop, https://docs.xfce.org/xfce/thunar/the-file-manager-window.] 

[image: ]If a volume showing in the Devices pane is mounted by clicking on it, it will also appear on the desktop. The contents can also be accessed by double clicking on the desktop icon.

	If any files are saved in foxclone, they will be lost when the system is rebooted. The file manager can be used to copy any files, e.g. screenshots or error logs to your system so they are available after reboot. The panel on the left shows all the devices (partitions) in the system. Click on any one to open.
Note that any partition with a label will display the label name, much more useful than 61GB volume – where you have to open it to look at the contents to figure out what it is.

[bookmark: _Toc63512874]Image viewer 
	Use to view any pictures, e.g. screenshots. It is easier to double click on an image file in the file manager to view it.
[bookmark: _Toc63512875]PDF reader
	The pdf reader is qpdfview and is used to display this document, the user guide.
[bookmark: _Screenshot][bookmark: _Toc63512876]Screenshot
	Screenshots can be taken with the keyboard shortcuts:
PrtScn – will take a screenshot of the whole screen.
Alt + PrtScn – will take a screenshot of the active window. The screenshot is automatically saved into /home/ubuntu.
[image: ]Return to troubleshooting


PrtScn will bring up a dialogue, click Take Screenshot and then Save to save a copy to /home/ubuntu.



[bookmark: _Toc63512877]Text editor
	The text editor is mousepad.
[image: ]
[bookmark: _Toc63512878][image: ]Internet




[bookmark: _Toc63512879]Pale Moon
	The web browser. The default home page is the foxclone website.
[image: ]
	You need to be connected to the internet. See Connecting to a network. 




[bookmark: _Toc63512880][image: ]System tools






[bookmark: _Toc63512881]Disks[footnoteRef:11] [11:  	Installed by default in most Linux distributions.] 

	Full name gnome-disks, use to mount and modify partitions. 
[image: ]
See here for more information on using Disks.
[bookmark: _Toc63512882]Disk Usage Analyser[footnoteRef:12]  [12:  	Installed by default in most Linux distributions.] 

[image: ]	This provides a graphical display of file/space usage within a partition. From the initial screen select the volume (partition) to be analysed. If a volume is not mounted, use the file manager to mount it (click on it in the devices pane)





[image: ]	Be warned – depending on the number of files and used space on a partition it can take a long time to display. The screenshot is a windows 10 C: partition.
[bookmark: _Disks][bookmark: _Toc63512883]File recovery
	A terminal program, photorec, for ‘disaster recovery’ to recover deleted files or lost data from a reformatted partition or corrupted file system.
[image: ]
	More information and a step-by-step guide can be found here: https://www.cgsecurity.org/wiki/PhotoRec_Step_By_Step.
[bookmark: _Gparted][bookmark: _Toc63512884]Gparted 
	The standard Linux partition utility. More information here.
[bookmark: _Toc63512885]GSmartControl
	A tool for querying and controlling SMART (self-monitoring, analysis and reporting technology) data on hard disks and solid state drives. It allows you to inspect the drive’s SMART data to determine health as well as run various tests on it.
More information:
https://www.Gsmartcontrol.sourceforge.io/home/index.php/About
[bookmark: _Toc63512886][image: ]Hardware Info
	A graphical front end for lshw – to view various hardware details about the system.

[bookmark: _Toc63512887]Terminal
	gnome-terminal, for running terminal commands or running foxclone to get debug info with foxclone --dump.
[image: ]
[bookmark: _Toc63512888]TestDisk
	A terminal program for data recovery. To quote “is powerful free data recovery software! It was primarily designed to help recover lost partitions and/or make non-booting disks bootable again when these symptoms are caused by faulty software”.
[image: ]
	More information and a step-by-step guide can be found here: https://www.cgsecurity.org/wiki/TestDisk_Step_By_Step
[bookmark: _Toc63512889]Preferences
[bookmark: _Toc63512890]Display 
[image: ]	Use to change display resolution. As an alternative to running Display, right click on the desktop.
Right click on the screen shown (LVDS-1), select Resolution and change as appropriate.
Useful if foxclone does not set the screen to the native resolution or if you want to reduce the resolution to magnify the screen to make it easier to read.
The display resolution can also be changed by right clicking on the desktop.
	When finished Layout > Apply.

[bookmark: _Network_connections][bookmark: _Re-sizing/adding_partitions_with][bookmark: _Connecting_to_a][bookmark: _Toc63512891]Connecting to a network
	Network status is shown by the icon bottom right of the screen:
	[image: ]
	[image: ]
	[image: ]
	[image: ]

	Not connected Default
	Connecting
	Wireless connected
	Wired connected


	To connect to a wired network simply plug in an ethernet cable. To connect to a wireless network, click on the network icon:Return to desktop
Return to web browser
Return to contact us

[image: ]1. Click on the network to connect
2. Click to set password

The network icon will change to connecting and if not secure will connect. If connecting to a secure network, click on the network icon again and select Edit Connections.Select the wifi network.
Click the gear icon to set the password.

[image: ]

[image: ]



Click on the Wi-Fi security tab.
Check the security protocol is correct (normally WPA2).
Enter password.
Save.





Finally, click the network icon again and select the network you have just set the password for and it will connect.
[bookmark: _Preparing_and_formatting][bookmark: _Toc63512892]Preparing and formatting drives
	When you buy an external drive, e.g. an external USB HDD, it will come formatted, normally fat32. There is no need to do anything unless you want to reformat it to ntfs or ext4, just plug it in and use it.
	If you buy an internal bare drive it will come unformatted. If you want to use the new drive for an operating system, you don’t need to do anything, the installer will format the drive for you. If you want to use it as a data drive you will need to format it.
	There are two Linux programs for formatting drives:
gnome-disks. This is installed by default in most Linux systems and normally appears as ‘Disks’ on the menu);
gparted. The gnome partition editor, this is not normally installed, but can be installed via the software manager or whatever software installation tool is provided with your Linux distribution.
[bookmark: _Formatting_a_drive][bookmark: _Toc63512893]Formatting a drive with Disks
	When you start Disks you are presented with this screen. 
[image: ]Return to Disks 

On the left, the drives in your system are shown, on the right, the contents of the selected drive. The gear icon provides options on what to do with the contents. The screenshot shows a ‘new’ unformatted drive.
[bookmark: Disks_problem]	A common mistake for newbies using Disks with a new drive is to click on the gear icon and select format.
[image: ][image: ]Return to backup
The Volume Name is the partition label. It is always a good idea to add labels.



The outcome is a partition on a drive with no partition table. If you try and backup this partition with foxclone it will give you a warning. While not necessarily bad, you will not be able to:
Use the partition as a destination for Timeshift snapshots.
Add more partitions.
	The correct way to format the drive is to add a partition table and then add partitions. Instead of clicking on the gear icon, click on the hamburger icon at the top of the screen and select Format Disk.
[image: ][image: ]
[image: ]Two choices are provided:

Compatible with all system (MBR), and
Modern systems (GPT).

[bookmark: Format_drive]If in doubt, choose GPT and click Format. An overview of partition table types is given here.
	When finished, not much has changed, but you now have a + button and the screen shows you now have a partition table.
[image: ]
Click + to add partitions – you can now have more than one partition and set the size of each partition. Here I have created two partitions, one ntfs and the other ext4 with the labels TestPart1 and TestPart2. The display is also now showing information about the selected partition.
[image: ]
[bookmark: _Formatting_a_drive_1][bookmark: _Toc63512894]Formatting a drive with gparted
	This is the same un-formatted drive used in the Disks example. Now when I try to create a partition on it (by right clicking in the unallocated area and selecting new), gparted gives me an error message. The drive is selected from the ‘drop down’ top right.
[image: ]Return to gparted

	To create a partition table, on the menu select Device > Create Partition Table. Select the partition table type (msdos = legacy = mbr, or gpt) and click Apply. More on partition tables here.
	To add a new partition, right click in the unallocated area and select new.
[image: ]
	The size can set by either entering the numbers or dragging the handles at the top, then click +Add.  Do not change the value shown for Free space preceding for the first partition on an MBR drive[footnoteRef:13]. Don’t forget to add a label. [13:  	IF an operating system is going to be installed, the second stage bootloader (grub for Linux) hides in the space between the end of the partition table and start of the first partition.] 

	Add as many partitions as required. At the bottom of the screen gparted will show a list of tasks to perform.
[image: ]
gparted will not make any changes to the drive until you select Edit > Apply All Operations from the menu.
	The outcome is shown below, the panel on the left can be displayed from 
View > Device Information on the menu.
[image: ]
	One ‘issue’ with gparted is that if you create an ext4 partition with it, the partition will be owned by root, so you won’t have write access. To fix this, boot your system as normal, mount the partition (in your file manager click on it – it should be showing in the panel on the left under devices) and in a terminal:
sudo chown $USER:$USER /media/you/mylabel
replacing you with your username and mylabel with the label you gave it when you created the partition[footnoteRef:14]. This changes ownership from root to you. [14:  	If you didn’t give the partition a label it will mount using the UUID, something like /media/you/ddc976e3-bc24-4b8d-9151-a72c9013d3e8 = not user friendly.] 

[bookmark: _Re-sizing/adding_partitions_with_1][bookmark: _Toc63512895]Re-sizing/adding partitions with gparted
	gparted can be found on the menu under system tools. It is the standard Linux partition editor. The screenshot shows the results of cloning a 240GB drive to a 320GB drive[footnoteRef:15]. The drive is selected from the ‘drop-down’ top right. [15:  	Note gparted shows sizes and usage in GiB, not GB, where 1GiB = 1.074 GB, https://www.gbmb.org/gib-to-gb] 
Return to clone
Un-allocated space 

[image: ]To see this pane, view > device information

	The drive is a Linux mint install with three partitions, two ext4 (/ and /home) and a swap partition. To use the unallocated space, either:
The swap partition (sdf3) must be moved to the right.
The /home partition (sdf2) needs to be re-sized.
Or a new partition needs to be created in the unallocated space.
	To resize or move an existing partition, right click on it and select Resize/Move. Click & drag on the partition to move it or click & drag on the right arrow to grow it, or enter the numbers. Click on Resize/Move to finish.
[image: ]Click & drag to re-size
Click & drag to move.

	When finished, Edit > Appy All Operations.
[image: ][image: ]Changes to be applied


[bookmark: _Partition_tables][bookmark: _Toc63512896]Partition tables
	A partition table sits at the beginning of a drive and tells the operating system:Return to backup
Return to format drive

How many partitions.
Where they are (start and finish, hence size as well).
The filesystems on the partitions, e.g. ntfs or ext4.
There are a number of different partition table types, but for practical purposes only two need to be considered – MBR and GPT. The choice of partition table type is driven by a number of factors, but mainly how the computer will boot – in legacy mode or UEFI mode.
[bookmark: _Toc63512897]MBR partition tables
	Also known as legacy or msdos. As the name implies, the original standard for partition tables[footnoteRef:16]. The partition table lives in the first sector (512 bytes) on the drive, so not a lot of space considering that some boot code has to fit in there as well. [16:  	Defined in 1983, so it is a miracle that it is still in use today. At the time a typical hard drive was 5MB or 10MB, enormous, that is, if you could afford one.] 

	The original characteristics of a legacy partition table were:
A maximum of four partitions.
A maximum partition size of 2TiB[footnoteRef:17]. [17:  	With a 512 byte sector size, by changing the sector size, e.g. to 4096 bytes, larger partitions could be used.] 

A maximum file size of 2TiB.
The limit on the number of partitions was a constraint and in 1986 a kludge was introduced – the extended partition. The extended partition is just a pointer in the partition table that points at another partition table that contains ‘logical’ partitions. So today a legacy partition table has:
A maximum of four primary partitions or three primary partitions and one extended partition.
An extended partition contains logical partitions.
A maximum partition size of 2TiB.
A maximum file size of 2TiB.
A takeaway from this is that if you have a drive larger than 2TiB (quite common now), you must format it with a GPT partition table.
	The screenshot (gparted) shows a dual boot drive with Windows and Linux.
[image: ]
Windows has used up two of the primary partitions (sdf1 & sdf2), leaving only two primary partitions for Linux. But in this setup, Linux wants three partitions – a / partition, a /home partition and a swap partition, so:
The third primary partition is used for / (sdf3).
An extended partition has been created, and 
The /home and swap partitions are logical partitions (sdf5 & sdf6) inside the extended partition.
Not particularly tidy! Note logical partitions will always start at sdX5 irrespective of the number of primary partitions you have.
	One thing to note with the latest ubiquity installer (used in Linux Mint 20 and a number of other ‘buntus). An automatic ‘erase and install’ option in legacy mode will create a primary fat32 partition (of no use to anyone) and then put everything else in an extended partition. This is a good reason for pre-partitioning your drive with gparted and using the ‘something else’ option during install.
	This is a useful Wikipedia article on legacy partition tables.
[bookmark: _Toc63512898]GPT partition tables
	Also known as a GUID[footnoteRef:18] partition table, a GPT partition table fixes the shortcomings of the legacy partition table. To do this, it is bigger, a legacy partition table is 1 sector at the start of the drive, a GPT partition table occupies the first 34 sectors. The characteristics of a GPT partition table are: [18:  	Globally Unique IDentifiers.] 

A maximum of 128 primary partitions, plenty enough for everyone and no need to mess around with extended partitions.
A maximum drive size of 8ZiB. That is 8,388,608TiB (I had to look it up). It will be a while before we hit this limit.
For practical purposes, maximum file sizes are so large as to no longer be a concern. There is one exception, fat32, with a maximum file size of 4GB[footnoteRef:19]. [19:  	Which is why foxclone automatically switches on file splitting when backing up to a fat32 partition.] 

	A further advantage of a GPT partition table is that there is a backup copy stored at the end of the drive. If the primary partition table at the start of the drive gets corrupted, it can be fixed. With a legacy partition table, if it gets corrupted, that’s it, you’ve lost the contents of the drive.
	Another feature of a GPT partition table is that it will allow you to assign a name to a partition in addition to a label. I’ve yet to find a use for the partition name.
	Another Wikipedia article, this time on GPT partition tables.  
[bookmark: _Toc63512899]Bootloaders and boot modes
	The two types of partition table are associated with two different boot modes:
MBR/msdos/legacy drives boot, unsurprisingly, in legacy mode.
GPT drives boot in UEFI[footnoteRef:20] mode. [20:  	Unified Extensible Firmware Interface.] 

It is possible to boot in UEFI mode from a legacy drive or boot legacy on a GPT drive, but that’s outside the scope of this guide.
	With legacy mode, the boot list in BIOS points at the boot drive, typically defined as HDD0, HDD1 and so on. BIOS then looks on that drive for the initial boot code which shares the first sector with the partition table. Not much space there, so this points at the second stage bootloader (for Linux this is normally grub). This ‘hides’ in the space between the end of the partition table and start of the first partition. This in turn, in Linux, points at /boot in your boot partition (normally / unless you have a separate /boot partition). 
	UEFI is the modern standard and just about every computer since about 2008 will support UEFI boot. If your computer came with Windows 10 installed it will almost certainly be UEFI boot. If Windows 7, then probably legacy boot.
	In UEFI, BIOS is more intelligent and looks for a special EFI partition on the drive and executes the programs in it. Instead of the boot entries in BIOS being specified by drive, e.g. HDD0, they are specified by the operating system, so you will see entries like ubuntu or windows boot loader. In the EFI partition is an EFI folder and inside that folders for each operating system. This is the contents of the EFI folder on a dual boot system, Windows with Linux Mint.
[image: ]
	This is what the drive looks like in gparted. It is dual boot, Windows 10 and Linux Mint.
[image: ]
Compared to the gparted screenshot of a legacy drive you can see an additional column for the partition name.
There is no extended partition – no need.
The EFI partition is sda2, it’s not very big (doesn’t need to be) but it must be formatted fat32 and must have the flags boot & esp set (this is what tells BIOS that it is the EFI partition).
	What type of partition table should I use?
If in doubt use GPT.
If your drive is larger than 2TiB you must use GPT.
If you want to dual boot Linux with windows and you are putting Linux on a separate drive, format the second drive the same as the first. So if windows is booting in legacy mode, format the second drive legacy and install Linux in legacy mode. If windows is booting in UEFI mode, format the second drive GPT and install Linux in UEFI mode.
[bookmark: _Toc63512900]Known issues
Confusion between MB/GB and MiB/GIB resulting in inconsistent partition/drive sizes being reported in different windows.
Hints will appear when the mouse hovers over objects such as buttons and checkboxes. This has not been implemented for all objects.
The tab order has not been set up on all windows. Pressing the Tab key will move around the objects in a window, but not necessarily in a sensible order. Generally, the Esc key will cancel and Enter is OK.
The iso – time/date displays may not match your locale – locales have not been set up. This may also result in incorrect keyboard layouts.
The iso – time may not reflect your location or daylight savings settings. The iso is locked to the PC’s hardware clock.
[bookmark: _Toc63512901]Troubleshooting
	Run into problems? Provide as much information as possible to assist fault finding.
[bookmark: _Take_a_screenshot][bookmark: _Toc63512902]Take a screenshot
	If it will help troubleshooting take a screenshot. Press PrtScn or it can be found on the Menu > Accessories. Save the file and then use the file manager to copy the screenshot file to one of your drives so it will still be there after you reboot.
[bookmark: _Toc63512903]Run foxclone in a terminal
	If the problem with foxclone is repeatable, then run foxclone from a terminal with either –dump or -d. It will dump output to the terminal which will aid in identifying the problem. 
[image: ]
foxclone --dump
or
foxclone -d






	To save the terminal output copy/paste from the terminal into the text editor and then File > Save. Then use the file manager to copy the file to one of your drives so it will still be there after you reboot.
[bookmark: _To_contact_us][bookmark: _Toc63512904]To contact us
	Email help@foxclone.com with any screenshots and/or text files with foxclone output. The more information describing the problem, the easier it is for us – help us to help you.
	Or, connect to the internet, click contact on the website and fill in the on-line form. Provide a description of the problem and copy/paste the terminal output from foxclone –dump.

[bookmark: _Toc63512905]How does it work?
	Foxclone is a front end for partclone, a terminal utility that backs up and restores a variety of partition types to/from image files (https://www.partclone.org). In addition to partclone, foxclone also uses:
blkid – to get partition labels. Also to determine the UUID of swap partitions so that when cloned, a swap partition has the same UUID and Linux will not hang for 90 seconds trying to find the wrong swap partition.
blockdev – to get the size of a drive in blocks.
cmp – on restore to compare partition tables to determine if changed.
dd – to copy and restore grub on a legacy drive.
df – to determine the number on used 1k blocks in a partition
grep – to filter output from other terminal commands.
hdparm – to get the serial number of a sata drive.
killall – to kill partclone when a backup is cancelled.
mkdir – make a folder.
mkswap – restore or clone a swap partition.
mount – mount a partition.
nvme – to get the serial number of a NVME drive.
os-prober – search for installed operating systems.
partclone – backup and restore partitions.
parted – get information on the drives and partitions in the system.
partprobe – to force the kernel to re-read the partition table after a change.
pigz – a multi-threaded alternative to gzip. Used to compress and decompress image files.
pkexec – together with a set of defined policies allows foxclone to run with root privileges. 
rmdir – remove a folder.
sfdisk – backup and restore partition tables.
swapon & swapoff – to turn swap on and off.
umount – unmount a partition.
uname – get the kernel version running in the ISO.
[bookmark: _Version_History][bookmark: _Ref42695575][bookmark: _Ref42695581][bookmark: _Toc63512906]Version HistoryReturn to restore


	V45
	Fixes a self-inflicted error restoring from a backup of a pcie NVME drive.

	V44
	In foxclone:
· Verify tab added with the ability to check image files.
· Log button added on most progress windows providing the ability to view logs generated in a restore or clone.
· Bug fix – previously an attempt to clone from an NVME pcie drive (or backup of an NVME pcie drive) to a sata drive would fail, now fixed.
· Bug fix – a backup or restore started shortly before midnight and continuing past will now display the correct time to completion.
In the ISO:
· The build scripts have been completely re-written. The outcome is largely unchanged from the previous version.

	V42
	In foxclone:
The warning message that foxclone can’t find a serial number has been removed (usually applies to USB sticks – adding no value).
Treatment of drive with no partition table, but a valid filesystem has been changed. Previously foxclone ignored the drive. Now it will allow it as a backup destination but will not allow it as a source.
Partition information displayed in list/checkboxes has been changed.
Default compression level changed to 1. Slightly faster with slightly larger backup files.
Minor bug fixes.
Significant update to the user guide.
In the ISO:
Thunar replaces pcmanfm as the file manager.
qpdfview replaces evince as the PDF viewer (user guide).
Networking enabled.
Pale Moon added as a web browser for access to the foxclone website.

	V40
	In previous versions, a restore identifies the drive to restore using the model name (as returned by parted). This may cause a problem in systems with two identical drives. A backup taken with V40 now records the drive model name and serial number. 

	V39
	Foxclone was hanging on a restore from a backup where the backup files were split. Bug fixed.

	V38
	In V37 cloning to a 2TB drive was reporting not enough space due to use of 32 bit integer functions. Changed to 64 bit functions and problem fixed.

	V37
	Where the backup destination is on a fat32 partition, automatically switches on ‘split files’ with a file size of 2048MB to avoid breaching the 4GB file size limit on a fat32 partition.

	V36
	Checks for any MS reserved partitions and sets the filesystem to unknown. V35 was incorrectly identifying an MS reserved partition as ext4 on a GPT format PCIE NVME drive.

	V35
	On a restore checks to see if the mount point for a drive has changed since the backup, e.g. from sdc to sdd. If changed asks the user if they want to continue the restore using the new mount point.

	V34
	Stops the user trying to backup or clone to/from the foxclone boot drive. Allows for more than 9 partitions on a drive (why would you want to do this?).

	V33
	Runs foxclone as root – users were having problems saving backups to partitions they had created on external drives and were owned by root. Bug fixes for NVME drives. Default mount point in foxclone changed from /media/foxclone to /mnt/foxclone. In LM19.3 was causing problems with the file manager trying to auto open partitions mounted in /media.

	V32
	Checks for ownership of the backup destination and rereads the system after a restore or clone. Minor internal changes.

	V31
	Bug fix to handle bios_grub partitions, found after testing with hybrid UEFI/legacy installs.

	V30
	Identifies drives with a valid filesystem but no partition table (gnome-disks allows you to do this) – not good practice. A warning is flagged up and the drive is ignored.

	V25
	Initial beta issue for testing.



[bookmark: _Toc63512907]The legal stuff
	Copyright © 2019 - 2021 Andy Hardwick.
[bookmark: _GoBack]	This source is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License as published by the Free Software Foundation; either version 2 of the License, or (at your option) any later version. 
	This code is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for more details.
	A copy of the GNU General Public License is available on the World Wide Web at 
	http://www.gnu.org/copyleft/gpl.html. 
	You can also obtain it by writing to the Free Software Foundation, Inc., 51 Franklin Street - Fifth Floor, Boston, MA 02110-1335, USA.    
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